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Create your flipping book from PDF files
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About FlippingBook Creator

FlippingBook Creator is your easy way to batch
convert ordinary PDF files into stunning booklets
with amazing page-flipping animations and sound!
Imagine being able to create digital magazines and
catalogs that behave like actual paper books
without any programming work! Once you've
created vyour page-flipping masterpiece in
FlippingBook Creator, you can publish it to the web,
via email, and even distribute it on CD-ROM, all

without paying royalties!

Note: This product is distributed on a "Try
before-you-buy" basis. All features described in this
documentation are enabled. The registered version
doesn't insert a watermark in your generated

page-flipping eBooks.
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Product features

1

2.

8.

9.

Convert PDF to Adobe© Flash® based page-flipping eBooks.

Output in 4 different formats: HTML, EXE, Zip and Burn to CD.

. HTML allows you to upload to a website to be viewed online.

EXE and Zip allow you to send to your user by email to be viewed

on their computer.

. Burn to CD allows you to burn to disk so you can send your user

physical media for viewing on their computer.

Preview the output effect instantly.

Batch convert multiple PDF files to a single or multiple
page-flipping eBooks.

Import bookmarks (outline) with PDF, and edit them manually.

Import hyperlinks with PDF, include web link, page link, email link.

10.Import text with so text is searchable.

11.Provide multiple templates (default provided or download from

website).

12.Set eBook size, choose landscape or portrait.

13.Add watermarks text, image, dynamic date/ time etc to

page-flipping ebooks.

14.Define titles, keywords and other metadata.
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15.Define titles, icon, window size for EXE page-flipping ebooks.

16.Define book margin size manually.

17.Add encryption to protect created page-flipping eBooks.

18.Retain the book to center or not.

19.Insert background music, always play or define times.

20.Set background color and image.

21.Set book reading from right to left (such as Arabic).

22.Choose hard cover for eBooks.

23.Set page-flipping time manually.

24.Customize toolbar buttons to set permissions for downloading,
printing, sharing and more.

25.Set colors for toolbar, book cover, book shadows, bookmarks and
more.

26.Set scale for zoom-in function.

27.Set control bars to "show" or "hide" in full screen.

28.Define language for flash.

29.Export and save settings for future uses.

30.Set output name mode within batch conversion.

31.Save current files and settings as project.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:
1. Drag the corner to flip a page.
2. Click page shadows to flip a page.
3. Input login password to view eBook content.
4. Auto-view flipbook repeatedly.
5. Auto-flip eBooks after loading.
6. View page thumbnails.
7. Use button to control page, such as Previous, Next, First, Last etc.
8. Flip pages automatically.
9. View page-flipping ebook full screen.
10.Search whole eBook.
11.Print out the whole ebook or a range of pages directly.
12.Download the uploaded page-flipping eBook from web site directly.
13. Double-click to zoom in or zoom out.
14.Zoom in/ out both pages.
15.Share eBook url via email.
16.0pen or close page-turning sound.
17.0pen to a certain page in Browser by adding a suffix like this:

index.html?pagelndex=4.
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Quick Start

e

v

1. Launch the application via the desktop shortcut =i,

2. Click the "Import PDF" icon "I:I to enter into Import PDF interface;
3. Click 22" licon to choose PDF file from your computer;

4. Click ImPerthow [;-q, to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

then click the "Apply Change" icon ;

ik

Fally 4

6. Click "Convert to Flipping Book" icon " to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

¥ @ -om

as example;
8. Click L #?"*= |{5 set Output Folder as "C:\flipbook", input File Name
as "demo";

| Lonvert |

9. At last, click icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

files book. swf demuo.html
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Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

ﬁ demo - Windows Internet Explorer == u

QO - |&] C\Flipbookidemo htmi |42 | % =] 8ing 2 '|_

¢ Favorites | w5

|gdemu ! | - ~ [ o= v Pagev Safety~ Toolks~ i@~ i

FLir PDF

& Internet | Protected Made: Off da v H100%

Interfaces

There are some main interfaces you will see while using FlippingBook
Creator as below shows: Application Options, Import PDF, Template
Settings, Language Option, Output, and Batch Convert.

You can enter into each page to get clear instructions for every detail

option.
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I. Application Options Interface

Render Engine Option

New version 3.0.0 provides 3 different render engines for you to create higher
quality page-flipping eBooks, click "Options->Application Options" to enter into
"Render Engine" interface:

Reendar Engane

Flease seleche a render engine for the conversion

Ehekd
El."."F
¥
[ =2
GPL Ghostsript Dpwioad Chostecript
F
[LTH ]

@ [rmer Library

SViF: Miuch legble characters, smaler output siee
. Ghostsorpt: Higher cofor ransfer gualbty

Inner Library: Faster convert speed

o | [ come

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when PDF imported failed)
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Il. Import PDF Interface

[ Import PDF M et |
Source POF Fie
sl Cocuments PoFs o PoF ol 7| powse. | [ gpena
The Page Ranges to Import Watermark
s HTF Place s custom text o imsge
Custom range; 2% H Watermark{Samp) to the flefs)
1 Quackly import {Orfy mport 10 pages o ksl preview) ISI_:’t_w-Put
Fage Quallty
Qualty ndsae: - [rgh ualeylerge le e ]

A High values produce befter page qualty but neguine mone dek space and mroe time to downioad.

o Uise first page's wadth and haight as page proporon,
| oot bockmnark Impord brics _ | Enable seardh

Panel Description:
1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Soenit | view content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©AlpagEs  Convert all pages to page-flipping eBook;

6 Custo 2k E 11,3,5,3-21 .
EEE e xample:1,3;5, Convert defined range page;

(9] Quicidy import (Orly import 10 pages to ritial previen) Just preview effect on first 10 pages.

3. Watermark

set Watermark Add image or text watermark to flipping pages.

[Pl Applying Watermark Check this option first to choose default stamps or add new ones:
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Page-flipping eBook
& Edit /
4  Add text stamp
= Addimage stamp-i asine waams — — o
Add Image Watermark
* Delete Image nae
Hame:  Image Watermark
+ Move down e e
#  Move up o et =
odm: 8 (3 peght: - &
ﬁlmmﬁ _ibewmnmg
Image Effact.
Dpacty: 0% 1 100%
Rotsgon: 4 * degen | s backround

Positon nmarpne  Margns

M|

4. Page Quality
There are five types of "Quality And Size":

Medium guality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options:

[V]use first page's width and height as page proportion Select this option to use first page's

proportion as book proportion, or you can define in Template Setting interface;

[} tmport bookmark If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

7| mpart links If your PDF file has links, check this to enable in flipbook;

Enable search ook this option to enable search functionality in created flipbook.

At last, click [ImPertNow | j06n to enter into template setting interface.
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lll. Template Settings Interface

i Fiip POF -- Flip POF Dvervew
File Comvert “Options Help

60 Uy wroorteor 4 (M apply Change £ 6 Convert To Flipping Book
' Desgn Settng | Boskmank |
Templabes

_-__—.[_
[ Bre S
Please cistomize the flash template here
Escok
Bl Sodnd
ElTool Sar |
Initial Shew | Thumbriais
Eliinks
Languags |Ergich
Sequnity Settings Pip Security

The new V3.0.0 provides three different templates at present: Classical, Float

and Spread.

Each template contains some unique settings, the below instructions will

show you details.

The design setting interface contains below main parts:

Choose Template
Book

Sound

Tool Bar

Bookmark

Initial Show

Links

Language

Security Settings
Render Engine Option
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Panel Description:

1. Choose Template:

Templates

‘ Ifl classical ‘H E&

Please customise the flash template here

: Classical ‘E|

Choose a

icon to select templates from below interface:

. ~chick to make a quack sebection)
Cal (More and more templates will be provided in future,)
i

Get More Themes Orilrve

r Tempiates
[E=] Classical
EE] Fioat
@ Spread

@ Click this icon is to save current settings as a TXT file for later uses;

¥\
Click this icon is to import stored setting file at once.

2. Book Panel:

_Hide Book Frame Bar

[HBoock Proportions

[BPage Shadow

. Hard Cover

EBeook

. Retain the book to center |No

. Page Badkground Color | LTOXfFFFf

Bad:gground anﬁg

F|||:.p|ng'|'|me

-11 -
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Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar:

| Hide Book Frame Bar |Yes hd|

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center:
| Retain the book to center |Yes i |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for

embedding special background image, such as advertisement or company log.

(4) Book Proportions:

| ElBook Proportions |
cooPegeMadth o 8S2
cooPage et e B0

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.
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(5) Book Margin:

A. Book Margin (set in Classical Template):

- BookMargm — ], S ‘

" pn argin

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

.. .2

“Bottom |

(6) Flash Window Color:
=

Flash Window Color

| Moxno00i-]

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Icon Color (only in Classical Template):

| JoxFrre =
7 Q — E

| Icon Color

Copyright 2010 by flippagemaker.com
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(8) Page Background Color:

. Page Background Color /HI0XFF8040.

User Document

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

(9) Page Shadow:

e L i_ﬁ A
Page Shadow Opadty 0.5
Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(10) Background Config:

A. Background Color:

Gradient Andle g0

/Gradient Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.
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HBackground Image |
Image File E\L (7).ipg] J
Image pasition |Scale to fif

Click the icon " =" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

C. Background Image setting in Float template:

| BlBackground Image
Outer Image File E:\Program.. l

Image position Scale to fit
Inner Image File E: ram.. |
Image position |Scale to fit

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right.

(11) Right to Left:
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

|. - R|ghtTo R R

Next Page
; Lz
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(12) Hard Cover:
If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover Yes

(13) Flipping time:

Flipping Time 0.6 Sets page flipping time in seconds according to your

needs. (Recommended second value is 0.6)

3. Sound Panel:

ESound ! -
Enable Sound |Enable |
Sound File m_ﬁ
Sound Logps |-1 |

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =]" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

4. Tool Bar:

HlTool Bar !
Tool bar |show
B Colk  I0x000000
Icon Color | Cloxffeef
ElZoom Config !
_Frint Enable Yes
Search Button |Show

Search Highlight Color | [J0xffff00
Download setting |

Ful SweenButton_|show

Full Screen Without Tool,..|No

Help Button |Show
Elshare Button !
EAuto Flip |
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(1) Tool bar (only in Classical Template):

Tool bar Shaow | Show or Hide Tool bar in created flipbook.

(2) Zoom Config:

BzoomConfig |
ofeominenable o Yes
Zoom Scale 1.5

ir

To Enable Zoon In functionality, choose "'Yes" in "Zoon in enable", then set "Zoom Scale", the

value is the times between zoomed page size and the current page size.

(3) Print Enable:
Print Enable Yes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
& Pnnt '

=) Print AY Pages
_) Print Current Page

) Print Renge
Example; 2 5,83-26

= Print

(4) Search Button:
SearchButton  [show
 Search Highlight Color | [0xffff00
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:
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Why Choose Flip POF?

(5) Download setting:

ElDownioad setting
Download Enable Yes .
[ Download URL 2DFDemo. pdf'

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.flippagemaker.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or
relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
PDF to the same path).

Then readers can click the icon n to download your uploaded PDF file directly.

(6) Full Screen:
To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button | Show

T
-,

AR

Then you can click icon E to view flipbook in Full Screen, click icon or "Esc"

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):
Full Screen Without Toal. . Yes

(7) Help Button:
To show tips about viewing flipbook, you can set "Show" in "Help Button" option:
Help Buttan Show

Then you can see the button and click to get the tips as below:

Copyright 2010 by flippagemaker.com
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'J Double click to room in or out

'ﬂ" Drag the page corner to view

(8) Share Button:
If you want your flipbook viewers to send the link to their friends or clients, you can add a
share button in your flipbook for readers to send out your flipbook link immediately:

Elshare Button .
Share Button Show
Email Subject Rear my fii...
Email Body finkX

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

(9) Auto Flip:

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

1Bl AR
 FipInterval |3
Play Count -1

T At ﬁ||:. whéﬁ 513rt|_||;. YES.. e

5. Initial Show (set in Float/ Spread Template):

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

it ] ile *
For Example, select "Thumbnails": l L L

Then you will get flipbook shown with below initial interface:
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6. Bookmark:

Design Seting | Bockmeark |
| ElBockmark

Font color | 000000
Background color 1 0 S AP F i
Eackoround sishs |1

Always Show Bockmark | True

Fanle Posstion Left

-
(V] Dveek i

E .HE'AQNEVS 3
[ 5

{f i pirchase
e —C—

Tide:  Dther products

Boge: &

FLir PDF

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be

adjusted automatically based on your defined flash window color), you can set "Font color",
"Background color", "Background alpha" (refers to the background opacity, value interval:
0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/

False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF"
interface, or you want to create new bookmarks for your flipbook, you can add bookmarks

even sub-bookmarks here, click "Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and

click on those bookmarks, it will jump to the defined page automatically
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7. Links:

If you have check "Import links" option in "Import PDF" interface, then you can define
settings here, choose "Mouse over color", "Link alpha" (refers to the link area opacity, value
interval: 0~1, "0" stands for the area is totally transparent), "Border color", "Border width"
and "Open Window->Blank/ Self".

8. Language

|_Language |English =]

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".

9. Security Settings:

| Security Settings |Single Pass |

If you want to protect your flash books with passwords, you can click "..." icon to enter into
"Flash Security Config" interface:

Sanghe' PEESvoded opiion Mesrs BhEt LSen need the pisword 1o view the fash boou

Exclode Front Pages optin is o st a page number, all lafer pages can't be
erremd without nputing sarevwsed.

Sequity Tyoe
Peo Sty

]
|
E\\g B Bl Naavamed) 11456

Prodect Fage Rangd
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Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4

algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)

ﬂ Apply Change

At last, click icon to apply the settings

IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:
i {i Language Settings & "

fou can new or edit a language for the Aash flipping book.
The Lablad column below is the string that will be displayed in the fiash.
w The language will be st in the flash template setiings

Language bame:  [Chnese v) [# vewiooguage| [ Mpeete | [Bsovees.] [ Ghiesd.. |

Language Seitngs

Label Labled - ] Edit
Frst Button wm—@

Next Page Button T—m@ =
Last Button mE—m

Pravious Page Sutton Bi—m

Download Button T#

Print Button $TED

Search Button fr

Boak Mark Button =B

Help Button Eeh

Enable FulScreen Button o

Disable FullSoreen Button =R

| e o bt T =

Panel Description:

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

Language Mame: [Engljs_h_ "]

Arabic
Chinese
O
French
Greek

You can also add other language for your own uses:

.
1. Click the button [ lew Lanauads | 5nd define name for the new language:
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'E.Nm!_anguage ﬁ-‘
NewLmquaqe|
Dame: French
[ ]

Click "OK" to save the new language in the list;

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":

Language Settings

Label

Kext Page Button
Last Button Last

Mext Page

I Edti Language Item

Previous Page Buttan Previous Pe —————————
Deveroad Button Dowvioed || St LEnuage Stritg |
Frink Button Brint
Seardh Butten saareh Label:  Frstutton
Book Mark Button Book Mark
Help Button Help |abaled:  Presmére]
Enable FulSmeen Button  Enabis Fuls
Dizable FullScreen Button Disable Fuld
| Eine e Pl Bugbbene Sownd Oin_§
| soveandegtnest | |

[

Cancel

Joe

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable Fullscreen Button

o imid P Bakbam

Labled

Premigre

Page suivante
Derniére

FPage précedente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
| o Smamd

J Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33l Load.,
Load language file saving before for current using:
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V. Output Interface

& Cutput Option

Output |

Output type

.f‘?‘ @ = % " g0 _:5‘% ok

Path

Oytput Folder; Ct'\Users\Administrator Desktop

File Nama: demo Jhtmi
Optons

HML Tithe: demo

[Bun toco

2:110,G: PLDS  DVD-ROM DH-16055 VD15

E."'”E'Ei

Output types:

:;3 @ =t

1.

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo

Set Keywords, Description or even Script in the below interface:

I Advanced Settings

e

HTML Advanced Settings
HTML Meta Settings
Title: demo

Keywords:  pdf, fipbook, page-fipping, ebook, online, website, flash, background, music

Description:  Mhis page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts

code such as Google
Analytics here,

o ) (o]

You can put some tracking

Need dosed <saipt>tag!
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2.

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking ”Advanced" icon: b T Rt i 7

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

files

Edemu.html

buuk.swf

Uncompress

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

3.

<

demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
i B Advanced Settings @ﬁ1

Exe Advanced Settings

Exe Window Info

Cgption: dema
Teon: d!ﬁ‘il o | [ pesair |
Windaw Size Option

&) Maimized Custom Size

& Full Screen

e ] [ ]

You can even burn the output flipbook to CD:

[¥]Burn to €D

CD Writer |D: 1:0;G: PLDS  DVD-ROM DH-16D55 VD15 ']

Disc title: |Page-Flipping eBook

After choosing output type, then check the option "Burn to CD", set "CD Writer", define

C i
"Disc title", at last click button to output flipbook in your defined type.
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VI. Batch Convert Interface

K Batch Convert

8 aAdd PDF Documents

[l
#

A addBles i Add Folder P hmac Al

Mams Path
A Fip POE E:ischid Documents POFs o POF. odf
JmFhp Printer Er'iisefil Documents POFs Fip Prnter pdf
J=Flip Word EriUzefid Documents POFs ip Word. pdf
=% Settings
Cutput Sethngs | POE Setbngs |

Output type

‘:‘3" = hemi ;@ .z Rl & e
Path

Oytput Folders CoiUsers \Admnisirator Desktop

File Mame: {PDF FieMame) - e
Fip POF
Optiare
Capgon:  {PDF Tige} - |y Aebvanced)

Miaosoft Word - demo3L docx
Merge Al POF Files to One FipBook
R Convert to Flash

1" Conwvert to Flash

UL

Panel Description:

1. Add PDF Documents:
o scaries

Click this icon to add PDF files from computer;

i Add Folder |

Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

% Remaove aﬁ Clear all @ Move Lip % Move Down

2. Settings:
(1). Output Settings:

i. Choose Output Type:

Output tvpe
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ii. Choose Output Path:

PDF to Page-Flipping eBook Utility

User Document

Path

Output Folder: ;::'l.leers'n,ﬂ.dminist'ator‘l,Desktop I [

You can also define output name pattern with FileName, Title, Subject and so on:

File Name: Iz

{PDF Title}
{PDF Subject}

,j-iDF .ﬁ.uﬂﬁnri
POF FileMame}

And after defining the File Name, you can preview the result example below:

File Mame: {PDF FileName} Flipping Bock =

Flip POF Flipping Book

iii. Define Output Option:

Options
Caption;  {FDF FileMame} -

Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

1 Advanced Settings R advanced Settings bt
HTML Advanced Settngs o | ["&ve Advancea settngs | ]
HTHL Mata Seltngs Exe Windaw Info
e i Caption: dlamey
Eewwords: o, fpbock, pege-fiopng, eback, orllng, webate, fash, badkaround, musc 3
B ey [ — ot |
Desopton: s page-fiopng eBook shows you the sturming flash effect on POF pages, & eon: R L] | |
Add Sooh Window Sire Opben
T can put some: rackng Maoomeped Cystom Sipe
mcm-sw
yties heve.
Meed dosed csoript »tag! B Eull Soreen
|

iv. Merge All PDF Files to One Flip Book:

[@]iverge All POF Files to One FlipBook:
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(2). PDF Settings:

i. Page Range:

The Page Ranges to Import
71 All pages

@ Example:1,9-21,30

You can convert "All pages" or just "Custom range";

ii. Watermark:

Watermark
'!-" . Place a custom text or image
W Watermark{Stamp) to the file{s)

o

Option - X
Watermark
V] Applying Watermark
Watermark MName TyYpe - |
4R Yrext -CONFIDENTIAL  Text |
[ A vt - FinAL Text -
7] A Text - COMPLETED Text s
[T A Text - CRAFT Text
[7] A Text - FOR PUBLIC RELEASE Text &
[T] A Text - INFORMATTON CNLY Text =
] A Text - NOT FOR PUBLIC RELEASE Text
[T A Text - NOT APPROVED Text A 3¢ :
D A Text - Company(Tie) Text =
E A Text -LOGO (efi-top) Text $ h
[F] A Text -LOGO (Right-Top) Text
[Tl A Text -LOGO (Left-Bottom) Text .
[7] A Text -LOGO (Right-Bottom) Tesxt
7T A Text - Dynamic - {tte) Text
[[] = image -LOGO image - |
ok | | cance |

Text Watermark, Add Image Watermark, Delete, Move Down/ Up.
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iii. Page Quality:

High guality large file size. T

Higher guali Iarer 'ﬁlE size

Medlum quallt’y me-:llum file size
Low guality small file size
Lower quality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options:

[¥] Use first page's width and height as page proportion Select this option to use first page's

proportion as book proportion, or you can define in Template Setting interface;

Wit bockanant If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

[ mport inks If your PDF file has links, check this to enable in flipbook;

7
IS ot search Check this option to enable search functionality in created flipbook.

"
Convert to Flash

-

At last, click icon to batch convert listed files together.
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License Agreements

All copyrights to FlippingBook Creator (the Software) are exclusively owned by
Flippagemaker.com. For more information, visit our website at www.Flippagemaker.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.flippagemaker.com/flippingbook-maker/index.html) or Order Toll

Free 1-877-353-7297 (When you order toll free just give the operator the product number of
the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at support@flippagemaker.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you don't get a satisfying solution, please
contact support team for help.

1. Frequently Asked Questions
You can find answers to questions about technique issues here:
http://www.flippagemaker.com/general-support.html

2. Learn tutorial about FlippingBook Creator

We publish a video tutorial which shows you the easy procedure of dealing with
FlippingBook Creator, you can view this video to quickly handle the stunning tool:
http://www.flippagemaker.com/flippingbook-maker/flippingbook-creator.swf

3. Get lost license code
Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us
If you have other questions or requirements, contact us directly through our support Email:
support@flippagemaker.com, we will respond you ASAP.
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